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This tutorial has been prepared by the Computer Support Group of the National 
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and contractors with NIEHS.  Although descriptions and recommendation appear 
to be in compliance with the guidelines set forth by Applied Biosystems for the 
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responsible for the contents of this tutorial. 
 
The appendices in this tutorial were taken from the installer disk for version 1.0 of 
Primer Express® and from a tutorial provided by Applied Biosystems and are 
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Introduction 
 
Primer Express® is a primer design program from Applied Biosystems that also 
allows for an easy design of compatible TaqMan® probes, for use in real-time 
PCR or end-point PCR analyses.  It can also be used for the design of primers 
alone when the user expects to analyze samples with SYBRGreen® only.  It will, 
therefore, be assumed that anyone taking this class is already familiar with the 
concepts behind real-time PCR and the relative advantages and limitations of 
using TaqMan® probes or SYBRGreen®.  Primer Express® exists in a version 1.5 
for use on a Macintosh platform and a version 2.0 for use on a PC platform.  Only 
very minor differences exists between the two versions and these should be 
noted during the class. 
 
By the end of this class, the users should be able to design primers and probes 
for their sequences of interest.  They should also be able to identify and use the 
different documents (search routines) available within Primer Express® and the 
annotation tools that can be used to limit their searches.  Finally, they should be 
able to understand how the default parameters, which define the searches, might 
be adjusted for more difficult sequences. 
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A Quick Start 
 

Initiating a new Primer/Probe search for Tamra-quenched 
probes. 
 

Activate TaqMan® Probe & Primer Design 
 

1. After opening Primer Express, From the File menu choose New 

2. Slide to the right and from the cascading menu choose TaqMan® Probe & 
Primer Design. 
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This will open up the TaqMan® Probe search screen at the Sequence tab. 
 

 
 

Sequence tab 
opens by default. 
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Introduce a target sequence 
 
Note: Although not officially documented, longer sequences (>3,000?) have 

been observed to yield less-than-optimal primer/probe sets or (>10,000?) 
no sets, at all.  Sequences of 300-1,000 bases typically yield 
abundant, optimal sets. 

 
There are two methods for bringing a target sequence into the TaqMan® probe 
screen: 
 

• Copying and pasting a sequence from another document. 

• By importing it. 
 

Copy and paste 
 

To copy the sequence: 
1. Select the nucleotide sequence from a Word or Text document.  

See the example of the Notepad file NM_006119 below. 

2. Highlight the nucleotide sequence  

3. Copy it onto the computer’s clipboard. From the Edit menu choose Copy. 
Keyboard shortcuts: Control(Ctrl)+C in Windows  

Command( )+C in Macintosh. 
 

 
 

Highlight 
nucleotide 
sequence. 

Do not include 
extra text or 
numbers. 
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Note: The numbers and/or annotations are okay but do not include extraneous 
information, such as the description of the sequence. 

 
To paste the sequence: 

1. Return to the Primer Express window. 

2. Select the Sequence tab (if it is no longer active). 

3. Paste the sequence. From the Edit menu choose 
Paste.  

Keyboard shortcuts: Control(Ctrl)+V in Win. 
Command( )+V in Mac. 

 
 
 
 
 
 

 
Note: The annotations may have changed. 

The pasted sequence 
will appear in the 
Sequence screen. It 
automatically replaces 
any text already in the 
screen. 
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Import the nucleotide sequence 
 

Instead of copy and paste, a sequence can be Imported into Primer 

Express: 

Note: The sequence must be in a tab-delimited text format. 

 

1. Click the Import DNA File button near the top of the Sequence 

page.   

2. The Open file window will appear. 

3. Navigate to the folder that contains your sequence.  

4. Select the file and choose Open 

 
 
Note: Before importing, remove all extraneous information from the file so 

it contains only the sequence.  The numbers and/or annotations are 
okay.  If the text is in a GenBank, EMBL, FASTA, GCG, or ASCII 
format, descriptive information will automatically be removed. 

 

 

Import button 
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Save a sequence 

The sequence can be saved in the Primer Express Archive 
Folder. (This is the default folder and cannot be changed.) 
 

1. From the File menu choose SaveAs. 
 
 
 
The Save Document window appears. 

2. In the Document Name 
field type the name for 
this sequence 

3. The User Name field will 
specify the Primer 
Express Archive Folder. 

4. Select the Save button 

 
 
 

The subsequent file will also specify that it was created for evaluation in the 
TaqMan® Probe and Primer Design document. 
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Start the Primer/Probe Search 
 

Generate acceptable primer/probe sets for the sequence 
 

1. Select the Sequence tab (if it is not already active). 

2. Verify that the box labeled Limit 3’ G+C, at the top of the Sequence 
page, is checked. 

Mac Users: Version 1.5 is unchecked by default 
Win Users: Version 2.0 is checked by default.  

3. Check the Limit 3’ G+C box if it is not checked. 

 

 

4. From the Options menu choose Find Primers/Probes Now  
Keyboard shortcuts: Control(Ctrl)+= in Win. 

Command( )+= in Mac. 
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View the generated acceptable primer/probe sets. 
The generated list contains up to 200 primer/probe sets.  Only one of 
the suggested sets is displayed on the Sequence screen. 
 
There are two(2) ways to immediately view the selected primer/probe set 
on the Sequence screen. 

 
1st view on Sequence screen 

 

Note: The reverse strand can be displayed by checking the Double Stranded 
box at the top of the Sequence page. 

The complement of the Reverse 
Primer is indicated by the Blue arrow 
pointing to the left. 

The Probe is indicated by the Green box. 

The Forward Primer is indicated by 
the Blue arrow pointing to the right. 
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2nd view on the Sequence screen 

 
TaqMan® Probe/Primer Data window located elsewhere on the screen. 
This window displays the same primer/probe set highlighted on the screen 
and includes some relevant parameters. 

 
 
 
 

Reverse Primer 

Forward Primer 
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View the entire list of primer/probe sets 
The entire list of primer/probe sets is under the Primers tab. Up to 200 sets 
are available. 

 

 
 
 

To select a different Primer or Probe click on it. 
 

The TaqMan® Probe/Primer Data window will change to reflect the 
new choice. 
The Sequence Screen will also change to reflect the new choice 

 
Note:  Any of the sets in this list will have passed the screening parameters 

(filters). Don’t consider the first set chosen to be the only or best option. 
 

The selected primer/probe 
set on the Sequence 
screen is highlighted here. 

Primers tab 

The screen may be too narrow 
to view more than the Forward 
Primer members of the sets. 
Scroll to the right to view 
Reverse Primers and Probes. 

Click on labels to sort by that 
column. 

Scroll to the right to view Reverse 
Primers and Probes. 

TaqMan® Probe/Primer Data 
window is still visible and 
displays highlighted set. For 
more information on this 
window, see page 9. 
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Get information for ordering a sequence 
 
The Order Button 
 

 
The Order… button at the bottom of the Primers page will display a text 
file describing the highlighted primers and probe from which the 
sequences can be copied and pasted into another text document. 
 

 

Copy and Paste 
any sequence  GGCTCCTCGGACTCGAACTC 
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Results tab 

 
This screen lists all the members of the highlighted set with some more 
detail than the TaqMan® Probe/Primer Data window. 

 
Results tab is useful because the primer and probe sequences can be 
copied from this page and pasted into other documents for records or for 
ordering them from other suppliers. 

 
Note:  The probe is incorrectly labeled Cycle Params:. 
 Also the data on the bottom half of the screen has been cut out of this 

picture because it is not useful for the present version of the software. 

Probe 
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Design guidelines 
 

Because most of the previously recommended guidelines (Appendix A) 
are now incorporated into the software, only one significant adjustment 
must be made. 
 

Proposed probe composition 
 

A. By default, the probe displayed is on the forward strand. 
B. The complement probe will have the same annealing temperature and 

would fit most of the same filters. 
C. The Probe with more C’s than G’s will perform better. 
D. Count the nucleotides to determine which probe has more C’s. 
E. Only choose the complement if it does not have a G at the 5’ end. 
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Restricting a search 
 

Facts: 
• Only 200 sets can be listed under the Primers tab. 

• Possibly many more passed all of the default filters but could 
not be displayed in this abbreviated report. 

• You may want to limit the search to distinguish mRNA from 
gDNA, to distinguish a particular gene from a family of 
similar genes, or to include genes from multiple species, for 
example. 

 
Conclusion: 

You may want to add custom restrictions to the filters to better 
refine your search. 
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Annotation tools 
 

1. Select the Sequence tab. 
 

2. The Eight(8) Tool buttons are visible to the left of the TaqMan® 
Probe window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: A more complete description of the tools is included in Appendix B of this 
document. 
 

Select the 
Sequence Tab 

Annotation Tools 
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Using the tools 
 

1. Press the button of the desired tool 
2. Highlight the corresponding site or sequence. 

 
Useful tools for TaqMan® searches are: 

 

 The Junction button can be used to specify a location across which a 
probe must be located.  For example, placing a probe across an intron 
junction will prevent genomic DNA from being amplified in conjunction with 
mRNA. 

 

 The Site button can similarly be used to identify a particular location 
(including an intron junction) but does not impose the probe restriction.  A 
short description can be entered at the designated site. 

 

 The Exclude button can be used to designate a region of the sequence 
which the user does not want to be included in the search for primers or 
probes. 

 

 The Line button can similarly identify a sequence of interest without 
imposing any restriction on the primer/probe search. 

 

   The Forward Primer, Reverse Primer, and Probe buttons can be 
used to specify any one of the corresponding oligonucleotides.  Typically, 
they might be used to “lock in” one of the components from the initial 
search, that is at a desirable location, to generate a list of sets with other 
components that would be compatible with it. 

 

 The eraser can be used to remove any of the 
previously placed annotations. 

 
 
 
Note: If there are several annotations and the user wants to 

remove all of them, from the Edit menu choose Clear 
All Annotations. 
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Opening some of the Filters 
 

If the initial search does not return any acceptable primer/probe sets, it 
may instead be necessary to alter or ease some of the restrictions on 
their design.   

 
WARNING: The default parameters were designed to provide the optimal 

designs and should not be altered without considering that doing so 
will be likely to yield less-than-optimal primers and/or probes. 

 
 

Limit 3’ G+C” box 
 

Deselect the Limit 3’ G+C” box located at the top right of the 
Sequence page 
 
Note: Performing a search without having this limitation is likely to 

yield some primers with more than two G’s or C’s in the final five 
bases at the 3’ end of the sequence.   

 
Outcome: Three G’s or C’s may still be acceptable, particularly if they 

are not sequential and/or they are not at the very end of 
the sequence. 

 
Avoid: Three or more G’s or C’s may facilitate formation of a GC 

Clamp, which could interfere with the optimal function of 
the primers, by facilitating primer-dimer formation, and 
should be avoided. 
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The Params tab. 
 

Many of the filter adjustments can be found under the Params tab 

 
A. Annealing temperature (Tm): Although Applied Biosystems 

strongly recommends that the annealing temperature (Tm) of 
primers be left at 59° to maintain standard conditions, this page is 
where the user could change this parameter. 
 

B. GC requirements %GC: The GC content of the primers could be 
changed although it is not recommended.   
 

C. Length requirements: The length parameters could be adjusted 
although it is not recommended. 

 
D. Amplicon Length: The Amplicon length can be changed. 

Max Length: The 150 bp upper limit is intended to ensure that 
the PCR will have close to 100% efficiency.  If this limit 
were to be increased, it should be anticipated that the PCR 
efficiency will be decreased.   

Min Length: While it is unlikely that an amplicon could be 
designed with less than 50 bp, this lower limit could also be 
increased (for example to create a larger amplicon for 
visualization on a gel) up to the Max Length. 

 
E. Probe beginning: Probes should not be designed with a G at 

their 5’ end. 

A. 

D. 

C. 

B. 

E. 

F. 
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F. Probe Annealing Temperature: The annealing temperature of the 

probe at 10° above the annealing temperature of the primers 
should not be changed except when designing probes for allele 
discrimination. 

 

Rxn Cond and Recipe tabs 
 

Although the parameters listed under the Rxn Cond and the Recipe 
tabs may appear to be inconsistent with Applied Biosystems mixes and 
standard reaction conditions, the user SHOULD NOT CHANGE any of 
them. 
 

Rxn Cond tab 

Although they may appear to be incorrect, some of these values may 
actually be modified and used in some of the calculations used by the 
Primer Express software.   
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Recipe tab  

 
WARNING: Changing Rxn Cond or Recipe tabs can result in improperly 
designed primer/probe sets.  These pages will be eliminated in future 
versions of the software to avoid confusion. 
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The Map tab 
 

The display under the Map tab illustrates the relative position of the 
primers and probes listed under the Primers tab. 
 
Compare a primer/probe to: 
 

1. The position of any annotations that were put on the sequence  
2. The Tm estimates along the sequence. 

 
 
This feature can be used to scan through the sets to locate those that may 
be in a region of interest or to identify a region that is likely to contain 
acceptable sets, based on the calculated Tm values, for a more limited 
search. 

Select 
primer/probe set 

Location of 
primer/probe set 
and Tm estimates. 
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Documents 
 

To locate other Documents, from the FILE menu choose NEW.  Although a 
more complete description of the documents is listed in Appendix C, the 
majority of the documents currently listed under this menu are of little utility 
for a TaqMan® Primer/Probe search. 
 
NOTE: Most document choices found on the FILE, NEW menu are not 

useful for a TaqMan® Primer/Probe search. 
 

Useful Documents 
 

TaqMan® MGB Probe & Primer Design 
 

This document is necessary for designing MGB probes.   
It incorporates the influence on the Probe Tm that results from the MGB 
“tail”. 

 
Note: The complement may not have the same Tm. 

 

DNA PCR  
 

Users who anticipate using only SYBRGreen® are still encouraged to 
design complete primer/probe sets.  This prepares them for any future 
decisions to use TaqMan® probes instead of SYBRGreen. 
 
Using probe restrictions may occasionally prevent the search from 
returning any acceptable primers.  In this case, the DNA PCR Document 
can be used to find only primers that pass the default filters.   
 

1. Removes the probe restrictions from the search 
2. Uses the same restrictions that have been set. 
3. The Junction tool is located between chosen primers rather than 

within a probe. 
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Primer Test 
 
Test potential sequences for primer or (non-MGB) probe consideration 
by copying and pasting the sequence of interest into the Primer Test 
Document. 
 
To use the Primer Test document: 

1. From the FILE menu choose NEW 
2. Slide over and choose PRIMER TEST 
3. Select the SEQUENCE tab 
4. Highlight the Forward or Reverse Primer you wish to test 
5. From the EDIT menu choose COPY (or COPY COMPLEMENT) 
6. Place cursor in the Forward or Reverse Primer field 
7. From the EDIT menu choose PASTE 

 
Primer Test document shows: 

A. Tm 
B. GC content 
C. Length of the 

sequence entered. 
D. Potential self-

complementarity.  
E. Potential primer-

dimer formation. 
 
 
 
 
 
 
 
 
 
 
 
These could be severe enough to have eliminated the sequence 
from consideration by one of the filters in the search program.   

 
Note: This information could be used to adjust default filters 
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The Primer Test Document can also be used to examine potential 
probes by copying and pasting.  To examine the probe complements: 

1. Select the sequence of interest 
2. From the EDIT menu choose Copy or Copy Complement from 

the Sequence listing (for the forward or reverse sequence, 
respectively) and Paste into the Primer Test Document. 

 

TaqMan® MGB Probe Test 
 

The TaqMan® MGB Probe Test Document incorporates the effect of the 
MGB on the Tm of the probe. 

 
To use the MGB Probe Test document: 

1. From the FILE menu choose NEW 

2. Slide over and choose TaqMan® MGB Probe Test Document 
3. Select the SEQUENCE tab from the MGB Probe & Primer 

Design Document 
4. Highlight the probe you wish to test 
5. From the EDIT menu choose COPY (or COPY COMPLEMENT) 
6. Place cursor in the Probe 1 or Probe 2 field 
7. From the EDIT menu choose PASTE 
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Test a sequence 

A sequence in either of these fields can be randomly tested.  
1. Highlight a portion of it.  
2. The Tm and other characteristics displayed correspond to the 

highlighted portion. 
 

 
 

Use an acceptable sequence 
 

If an acceptable sequence is thus identified, Remove the remaining 
sequence. From the EDIT menu choose TRIM. 
 
 
Note: That the complement sequence probably won’t have the 

same Tm because the effect of the MGB is influenced by the 
nearest nucleotides. 

 
8. The chosen sequence can be “locked” into a search on the 

MGB Probe & Primer Design Document, using the Probe 
annotation tool, as described on page 15. 

Displays reflect only 
the highlighted 
portion of sequence 
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Appendix A:  Summary of Design Guidelines 
 

TaqMan Probe®: 
 
1. Keep the G-C content in the 30-80% range. 
2. Avoid runs of an identical nucleotide.  This is especially true for guanine, where 

runs of four or more Gs should be avoided. 
3. Do not put Gs on the 5’ end. 
4. Select the strand that gives the probe more Cs than Gs. 
5. For single-probe assays, Tm should be 68-70°C when using Primer Express® 

software. 
 

Primers: 
 
1. Choose the primers after the probe. 
2. Design the primers as close as possible to the probe without overlapping the 

probe. 
3. Keep the G-C content in the 30-80% range. 
4. Avoid runs of an identical nucleotide.  This is especially true for guanine, where 

runs of four our more Gs should be avoided. 
5. When using Primer Express® software, the Tm should be 58-60°C. 
6. The five nucleotides at the 3’ end should have no more than two G and/or C 

bases. 
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Appendix B:  Annotation Tools 
 

The use of some of the Annotation Tools can affect what primer pairs are 
returned by the program: 

 

Target Tool: 
Selecting a region with the Target Tool tells Primer Express to require that any 
primer pair returned would result in the region being amplified.  If a target has 
been selected by the user, Primer Express tests each candidate primer pair to 
determine if the target region is amplified.  The number of such primer pairs is 
shown in Interim Results as Number Passing Required Test. 

 

Exclude Tool: 
Selecting a region with the Exclude Tool tells Primer Express not to return any 
primer pairs that would amplify any of the sequence marked as excluded.  If a 
region has been marked as excluded by the user, Primer Express tests each 
candidate primer to determine if any excluded region is amplified.  All primer pairs 
that avoid excluded regions are tested further, and the number of such primer 
pairs is shown in Interim Results as Number Passing Avoid Ignores Test. 

 

Primer Tools: 
The Forward and Reverse Primer Tools allow the user to specify one or both 
primers by dragging through the sequence.  Primers specified by the user do not 
need to meet the criteria specified in the Params page.  Users may also specify 
just the 3' most residue of one or both primers using the F Primer 3' End Tool or 
the R Primer 3' End Tool.  Primer Express does test primers against the criteria in 
the Params page when this tool is used, and, in addition, only examines 
subsequences ending with the specified residue. 

 

Junction Tool:  
The Junction Tool can be used to require Primer Express to return only those 
primer pairs where at least one primer of the pair crosses at least one juction in 
the template.  The usual use for this is to create primers that will only amplify 
mRNA (or cDNA made from it) and not genomic DNA by marking the positions of 
the exon junctions with this tool. 



D1 

Appendix C:  Documents 
 
The same basic steps are used for finding primers in each of the document types 
supported by Primer Express, with variations based on the particular of the document 
type: 
 

RT PCR:   
Finds primers exactly as does DNA PCR, the only difference being that RT PCR 
documents look for and remove intron features in imported DNA sequences, and 
mark their location with a Junction annotation. 

 

Nested PCR:  
Follows all the steps described above, but additionally examines each acceptable 
primer pair to find those that nest within each other.  All such sets, each made up 
of an internal primer pair and an external primer pair, are returned to the user. 

 

Allele Specific PCR:  
Unlike any of the other Primer Express document classes, this document imports 
alignments of sequences.  The user can then mark which sequences in the 
alignment should be amplified by any returned primers and which should not be 
amplified.  Primer Express then determines which residue positions discriminate 
between sequences in the amplified set and those in the not-amplified set.  A 
normal primer pair seach then takes place, but each primer pair found is 
evaluated to determine if it contains a discriminatory residue.  The position of the 
discriminatory residue in the primer is a criterion that the user can set using 
Discriminatory residues must be within the last x residues from 3' end in the 
Primer Composition Requirements.  Only those primer pairs that contain 
discriminatory residues within the specific region are returned to the user. 

 

Multiplex PCR:  
The goal of Multiplex is to find many sets of primers that can be used in the same 
PCR reaction to amplify many different sequences simultaneously.  The user can 
specify any number of targets within a sequence using the Target Tools, or, 
import multiple sequences, with the assumption that each of these sequences 
should be amplified by one primer pair.  For multiplex PCR to be accomplished 
the primer pairs must meet all the usual criteria, but in addition, the Tm values for 
all of the primers in the reaction must be fairly close, and no primer dimer 
reactions can occur between any of the primers in the reaction.  In addition, the 
amplified products of the various PCR reactions must differ from each other 
enough in length that they can be distinguished by electrophoresis.  Primer 
Express finds multiplex sets that match these criteria by first finding all acceptable 
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primer pairs for each of the targets, then testing every combination and returning 
those sets that meet the criteria.  A special criterion on primers in multiplex is the 
Last four positions contain value, which, by requiring that all the primers have 
lots of C's but no G's (or lots of G's but no C's, etc.) at their 3' ends, essentially 
prevents the possibility of primer dimer.  Other criteria include the Maximal Tm 
difference between sets value, which guarantees that all primer pairs in the 
multiplex have similar Tms, and the Min spacing value, found in the Amplicon 
requirements, which ensures that the amplicon lengths are different enough to 
be distinguishable. 

 

TaqMan:   
The TaqMan document returns sets composed of a primer pair and a TaqMan 
probe.  Primer Express finds these by first finding all acceptable primer pairs, 
using the standard criteria, and then finding TaqMan probes that would hybridize 
between the primer pairs.  The user can set two criteria for the TaqMan probes: 
The minimum amount by which the TaqMan probe Tm exceeds the Tm of the 
primer pairs, and whether TaqMan probes should be restricted from begining with 
G. Primer Express tests candidate TaqMan probes using essentially the same 
methods used for candidate primers to determine Tm, to search for significant 
internal secondary structure, and to determine whether the candidate probe has 
significant sequence similarity to any other region of the sequence.  Only those 
candidate probes that pass these tests are returned to the user as TaqMan sets. 

 

Sequencing Primers:  
Primer Express uses the same criteria to evaluate candidate sequencing primers 
that it used to evaluate PCR primers.  In addition, however, the user can specify 
Primer Position Requirements to make certain that all primers returned are a 
specified distance from the end towards which they prime. 

 


